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TOOL

Tool

NAME
RapidProM Library

VENDOR
Developed by - Eindhoven University of Technology, Open Source

Maintained by - RWTH Aachen University, Open Source

VERSION
4.0.1

REQUESTED CERTIFICATION LEVELS
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META

Meta

AUTHORS
Madhavi Shankar

Madhavi.shankar@pads.rwth-aachen.de

DATE
12/11/2020

HISTORY

CHANGES

AUTHOR(S) DATE DESCRIPTION
Madhavi Shankar 12/11/2020 Initial recordings for the certification
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IMPORT

Import

INSTALLATION AND GETTING STARTED

1. Firstly install the latest version of RapidMiner ( current version is 9.8) from
https://my.rapidminer.com/nexus/account/index.html#downloads.

2. Go to “Extensions” in Menu and select “MarketPlace (Updates and Extensions)..

3. Inthe Search bar, type “RapidProM” and look for the latest version of RapidProM (Currently 4.0.1) and
select for installation.

4. Once installation is complete restart RapidMiner tool
4.1. Go to Operators -> Extensions ->RapidProM.
4.1.1. We can different packages here for import, export of logs.
4.1.2. We can also find packages to perform discovery, analysis, conformance and conversions.

To start working with RapidPRoM:

Launch RapidMiner

From Menu Click on File->New Process

Choose Blank Process from the popup menu

Go to Operators -> Extensions ->RapidProM ->Import
Drag and drop “Import Event Log” to the process page

o 1w

Connect to the res
Wl <new process*> ~ RapidMiner Studio Educational 9.8.000 @ DESKTOP-DRNNUHT - O X

File Edit Process View Connections Seftings Extensions Help

. |Editthe process setu|
| H mA i g £ | ’ v| . Views: Design Results Turba Prep Auto Model | Hore v ‘ |.: d data, operators...ec ;J‘ All Studio I

Operators Process Parameters
3
Search for Operators @ Process » P L 2P [§ G o [ |waimportEventlog
- o A file | = ‘G)
» 7] Scoring (14) S

» [ Validation (30) Import Event Log o

s importer Naive
» [ Utility (85) inp .la ot [)
¥ 7 Extensions (60) ! =

» | Model Deployment Manageme
I RapidProM (58)

b [ Analysis (9)

» 7] Conformance (4)

» ] Conversion (7)

b [ Discovery (9)

¥ B3 Export (2)

.'; Export Petri net
X, Export Event Log
¥ B Import (5)

) Extract Event Log

.’3 Import Accepting Petri Ne z Hide advanced parameters
14 Import Event Log
X, Import CPN Model Help
4 Import Petri Net .
» "1 Log Manipulation (8) v 4+ Import Event Log
] > RapidProM
’ Get more operators from the Tags: Import
Marketplace v
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IMPORT

7. Choose alog on the right in Parameters sections

u@l <new process™> — RapidMiner Studio Educational 9.8.000 @ DESKTOP-DRNNUHT = O X
File Edit Prg ) Open File w
. | B | Al
I':‘_ h Please select a file to open D_ Studio *
Operators
~ 1 Real-life v - kA Ei& R~ F
Search p
= Ra |dProM(§ Bookmarks File Name Size Type Last Modifi... ;ﬂpl O]
e Rap -\ — Last Directory BT BRIC12.xe5 70MB  XES File Aug 13,2020 AL -
b [ Analysis ( L BRIC13_closed_problems xes IMB  XESFile Aug 13, 2020 - o
— v
» [ Conformal @ BPIC13_incidents xes 37MB  XESFile Aug 13,2020 P
» ] Conversiol @' BPIC13_open_problems.xes 1MB XES File Aug 13, 2020
» [ Discovery @ BPIC15_1.xes J9MB  XESFile Aug 13,2020
e BT BPIC15_2.xes 32MB  XESFile Aug13, 2020
L =X EL BRIC15_3xes 44MB  XESFile Aug 13, 2020
|}
™ 5 Import (5) B BPIC15_4xes IBEMB  XESFile Aug 13, 2020
) Exract B BRIC15_5.xes 43MB  XESFile Aug 13, 2020
L4=|mpgn @'EPICﬁ—Dﬁerlog.xeS 105 MB XES File Aug 13, 2020
L‘i Import E‘ BRIC17 xes 552 MB XESFile Aug 13, 2020
@' MPNA1709 xes 947 KB XES File Sep 17, 2020
L'; Import
@ MPMN17091.xe3 AMB  XESFile Sep 17, 2020 v
% Import =
b 7 Log Manig BRIC12.xes
< Il | | file (*xes) M ~
Get more o -
, from the M3 ~ Open x Cancal y

8. Click on play button or press F11
9. To change the event log Click on “Design” in views and you will be redirected to step 6

Note: The screenshots displayed under each import log will only be the final one after step 8, which shows
the log summary.
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REAL-LIFE LOGS

SANITIZED BPIC LOGS

NAME TRACES EVENTS
BPIC12 13,087 262,200
BPIC13_closed_problems 1,487 6,660
BPIC13_incidents 7,554 65,533
BPIC13_open_problems 819 2,351
BPIC15_1 1,199 52,217
BPIC15_2 832 44,354
BPIC15_3 1,409 59,681
BPIC15_4 1,053 47,293
BPIC15_5 1,156 59,083
BPIC17 - Offer log 42,995 193,849
BPIC17 31,509 1,202,267
BPIC12

il <new process™ - RapidMiner Studio Educational 9.8.000 @ DESKTOP-DRNNUHT

File Edit Process View Connections Seftings Extensions Help

SIZE IN KB
72,363
4,090
38,627
1,370
40,261
33,616
45,673
36,131
44,961
107,557
565,373

X

B | ! H v b v . Views Design Results Turbo Prep More =

p| All Studio v

Result History H XLoglOObject (Import Event Log)
default reng i

Dashboard

R Q

(dotted chart) ry

»E
Xlog
(dotted chart - lega|

(exampleset) ry

Originators
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BPIC13_closed_problems
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il <new process*s — RapidMiner Studio Educational 9.8.000 @ DESKTOP-DRNNUHT

File Edit Process View Connections Settings Extensions Help
«
BiE- -l

Result History E XLoglOObject {Import Event Log)

S0 Design Results Turbo Prep More = Fina

£ Al Studio v

Xlog default renderel
1

defaultreng

(dotted chart) rf

Xlog
(dotted chart - 1ega|

(exampleset) rf




BPIC13_incidents

Origin

Mean 4
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BPIC13_open_problems

Mean
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BPIC15_1

Result History: Display a list of results ofthis session's processes.

Mean 44

Mean 43

BPIC15_2

Mean
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BPIC15_3

Page 10



BPIC15_4

Events

Mean

Originat

Mean 44

BPIC15_5
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BPIC17 - Offer log

193849

Mean
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BPIC17

&

Dashboard

ARTIFICIAL LOGS

FILTERED REPAIREXAMPLE LOGS

NAME
LevelAl
LevelA2

LevelB1

LevelB2
LevelC1

LevelC2

LevelD1
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LEVEL
Al
A2

B1

B2

C1

C2

D1

EVENT ATTRIBUTE KEYS (IF BOLD THEN GLOBAL)

concept:name

Classifier (concept:name AND lifecycle:transition)
concept:name,

lifecycle:transition,

time:timestamp

Classifier (concept:name AND lifecycle:transition),
time:timestamp

concept:name,

org:resource

Classifier (concept:name AND lifecycle:transition),
org:resource

concept:name,

concept:instance,

lifecycle:transition,



org:resource,
org:group,
org:role,
time:timestamp

Classifier (concept:name AND lifecycle:transition),
concept:instance,
org:resource,
org:group,

org:role,
time:timestamp
defectFixed,
defectType,

Key 1,

Key 2,

Key 3,

FlagX1 X1 Key 4,

Key 6,

phoneType,
numberRepairs,
{0,1,2} 2Sa!! +1 <x>,
ITEMS:41, #1,0.1.1
defectFixed,
defectType,

Classifier (Key 1 AND Key 6),
Key 2,

Key 3,

Key 4,

phoneType,
numberRepairs,
{0,1,2} 2Sa!! +1 <x>,
ITEMS:41, #1,0.1.1

ATTRIBUTE TYPES AND VALUES

LevelD2 D2

FlagX2 X2

KEYS TYPE VALUES
instance 1

concept:instance strin instance 2

Key 2 & instance 3
instance 4

Analyze Defect+complete

Analyze Defect+start

Archive Repair+complete
concept:name (A1l and C1 logs) string Inform User+complete

Register+complete

Repair (Complex)+complete

Repair (Complex)+start
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concept:name (other logs)
Key 1

lifecycle:transition
Key 6

org:group
{0,1,2} 2Sa!! +1 <x>

org:resource
Key 3

org:role
ITEMS:41, #1, 0.1.1

time:timestamp
Key 4

defectFixed

defectType

string

string

string

string

string

date

boolean

int

Repair (Simple)+complete
Repair (Simple)+start
Restart Repair+complete
Test Repair+complete
Test Repair+start

Analyze Defect
Archive Repair
Inform User
Register

Repair (Simple)
Repair (Complex)
Restart Repair
Test Repair

start
complete

Group -
Group 1, 3,and 5
Group 2 and 4
SolverC1
SolverC2
SolverC3
SolverS1
SolverS2
SolverS3
System
Tester1
Tester2
Tester3
Tester4
Tester5
Tester6

Role 1, 2,and 3
Role 10
Role 9

Like 1970-01-02T12:23:56.720+01:00

true
false

1
10
2

NO Ul bW
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numberRepairs

phoneType

Level A1

Page 16

Originators

int

String

Mean

Mean
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Repository Operators Process
. Process ¢
» [ Modeling (167) A
¥ [ Scoring (14)
b [ Validation (30) inp

» [ Uty 85)
[ Exensions (60)

» [ Model Deployment Hianagement (2)

™ RapidProM (58)

b [ Analysis (9)

b [ Conformance (4)

b [ Conversion (7)

v [ Discovery (9)
) Alpha Miner (Petri Net)
) ILP Miner {Petri Net)
. Evolutionary Tree Minar (Process Tre —
. Heuristics Miner (Heuristics Net)
 Inductive Miner (Petri Net)
) Inducive Miner (Process Tree)
. Bocial Network Miner (Social Network
. Transition System Miner (Transition &
) Fuzzy Miner (Fuzzy Hodel)

b [ Export (2)

» [ mport(5)
N

Log Manipulation (8)
b [7] Streams (13)

il PetriNetiOObject (Inductive Miner (Petri Net)
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250%

@ 54%

Import Event Log

Parameters

PP Pk BTl %, Import Event Log

file an import logs/ArtificiallLevelA1 xes B0
Inductive Miner (Pet...

b oo (e mod [) L
i J ]

T} Show atvanced parameters

a“

Help

A

+ Import Event Log
- RapidProM

Tags: Import

Synapsis

This operator can be used toimport a ProM XES
eventloe fromafile.




Level A2

- concept (Concept)
@ Global Trace Attributes
onceptname

@ Global Event Attribut

nceptname
B lifecycletransition
B8 Attribut

B conceptname
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. PetriNetlOObject (Inductive Miner (Petri Net))

H PetriNetlOObject (Inductive Miner (Petri Net))

wooz °

finform:
luser+comp]

The image with zoom-in, clearly shows the correct combinations of concept names and lifecycle transitions
(as defined by the classifier (Name AND Transition)) as activity names.
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Level B1

Log Attributes

lue:
complete

I onceptname
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Level B2

A XLoglOObject (Import Event Log)

Log Attributes

nceptname
8 Global Event Attributes

nceptname

onceptname
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Level C1

&8 Global Tra
I conceptname

@ Global Event Attributes
I conceptname
B orgr

I Cl ifi

& Attributes

I conceptname

Level C2

Hl XLoglOObject (Import Event Log)

obal Event Atfributes
ummar

nceptname

I conceptname
. lifecycle:tran:
8 Attribute:

[ ] ceptname
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Level D1

M XLoglOObject (Import Event Log)

[ Erowser N Exolorer | Log Attributes

| default renderer

Log
@ Extensions
. org (Organizational)
. time (Time)

& Attribute

I conceptname

Level D2

XLoglOObject (Import Event Log)

Log
8 Extensions
I org (Organizational)
B time (Time)

ummar
al Event Attribut

nceptname
nceptinstance

I lifecycle:

W orgresource

W org:group

B Attribut

B conceptname
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EXPORT

Export

We know from import cases, that it works for levels A1 and A2. Hence, we try the export for the same levels.

We do this by first importing the log for the given level, export that log to a file, import the log from that file
again, and show that the result are the same as with the import as shown in the previous section.
Steps to run export and test :

1. Create a process to import a log file and export the event log

1) <new process* ~RapidMiner Studio Educational 9.8000 @ DESKTOP-DRNNUHT - o x
Flle Edit Procsss View Conmections Setings Extensions Help
A o] H v } v . Views: Design Results Turbo Prep AutoModel | Deployments ‘: d data, operators...elc » ‘ All Studio » ‘
Repository Operators Process Parameters
earch for Ope © Process » PP 2P % @ [ | vaEwortiventlo
» - ) folder |\ = o
) Heuristics Miner (Heuristics Nt} —
) Inductive Hiner (Petr Net) rort entLog et file name 6]
) Inductive Miner (Process Tree) " - "o -
) Social Network Miner (Social Network) d i ™ e format xes v |0
) Transttion System Miner (Transition System)
) Fuzy Miner (Fuzzy Model)
v 7 Expot (2)
¥, Export Petr net
%, Export EventLog
~ P Impot (5)
) ExtractEvent Log
% Import Aceepting Petri Net
% Import Event Log
% Import CPN Hodel
ok Import Petri Net
~ [ Log Manipulation (8) |
AddNoise =
Add Classifierto EventLog Help
‘Add Arifical Start and End Event + Export Event Log &
Add Trace Atiributes to Log E& o pidprom =
Merge EventLogs T B
Add Event Atrbutes to Log Synopsis
k=it This operator can be used to export an event log.
Sort chronologically
v I streams (13) v Description
@ mu:ﬂ erstors from he Harkelblace This operator can be used to export a event log.
[Wissing something? Open the marketplace dialog and search for extensions which bring addfional funchanalit to RapiWiner Studio | 15 oe fortnat XE5, KES.GZ, MKML.and MXMLGZ 1Y)

2. Inthe parameter window(right side of the screen, in our case), configure the output folder.
3. For every test click on “import event log” and change its parameter for a new event log file.
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EXPORT

Process Parameters
@ Process » PP e i% @ B %, Import Event Log
file port logs/Arificial/lLevelA1 xes ‘ = ‘G
Import Event Log Export Event Log
N = s | importer Naive ¥ |d
» out {{inn thr [}
v v -

z Hide advanced parameters

Help

4 Import Event Log
RapidProm

Tags: Import

Synopsis

This operator can be used to import a ProM XES
event log from a file.

Description
This operator can be used to import a ProM XES

4. Similarly click on “Export Event Log” and configure the output file name

Process Parameters
1
O process » PP EE [ e[ wbwrbell
folder vimport logs/ExportedLogs ‘ = ‘@
Import Event Log Export Event Log
file name Level&1Exported (6]
inp Cinp 4t L]
ﬂ res
v file format 185 v @

5. You can later import these newly exported files and validate the contents by just running the import
as we did in the import cases.
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EXPORT

In addition, the steps are described above and only the screenshot of result will be given in the
individual sections.

Level Al
v logs » xes_certification_import_logs » XES certification import logs » Exportedlogs W
Mame v [Date modified
E‘ LevelA1Exported 11-11-2020 11:56

Event types
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EXPORT

Level A2
» logs » xes_certification_import_logs » XES certification import logs » ExportedLogs v | O £ Search ExportedLogs
Mame Date medified Type
E LevelAZExported 11-11-2020 11:59 KES File
E‘ LevelATExported 11-11-2020 11:36 KES File

Mean
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EXPORT

Level B1

&
Q
Cl

Class

Test Repair+complete
Test Repair+start
Register+complete
Analyze Defect+complete
Analyze Defect+start
Inform User+complete
Archive Repair+complete
Repair (Simple)+start
Repair (Simple)+complete

Occurrences (absolute)
1508
1508
1104
1104
1104

Occurrences (relative)
12.72%
12.72%
9.313%
9.313%
9.313%
0.206%
8.435%
6.622%

6.622%

» logs » xes_certification_import_logs » XES certification impert logs » Exportedlogs v O 2 Search ExportedLogs
Name Date modified Type
E‘ LevelB1Exported 11-11-2020113:39 XES File
E' LevelA2Exported 11-11-2020 11:39 XES File
E‘ LevelAlExported 11-11-2020 11:36 XES File
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EXPORT

Log Attributes

ns
I time (Time)
W iifecycle (Life
I concept (Concept)
S Global Trace Attributes
. conceptname
8 Global Event Attributes

I conceptname

W conceptname
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EXPORT

Level B2
» logs » xes_certification_import_logs » XES certification import legs + Expoertedlogs v O 2 Search ExportedLogs
Narne Date modified Type
E‘ LevelB2Exported 11-11-2020 14:01 XES File
E‘ LevelB1Exported 11-11-2020 14:00 XES File
E‘ LevelAZExported 11-11-2020 11:39 XES File
E‘ LevelA1Exported 11-11-2020 11:36 XES File

Log Attributes

ptname
it Attributes

Transition)

I conceptname
I lifie ransition

& Attriby

I conceptname
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EXPORT

Level C1
» logs » xes_certification_import_logs » XES certification importlogs » ExportedLogs v 0 D Search Exportedlogs

Name Date modified Type

[T LevelClExported 11-11-2020 14:02 KES File
[T LevelB2Exported 11-11-202014:01 KES File
[T LevelBiExported 11-11-2020 14:00 KES File
E‘ LevelA2Exported 11-11-202011:59 AES File
T LevelAlExported 11-11-2020 11:36 KES File

Log Attributes

ndard.orglorg.xesext

pt (Conce
Attributes
ptname
Attributes
I conceptname
B oo
I ifie
B Attribu

B conceptname
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EXPORT

Level C2
» logs » xes_certification_import_logs » XES certification importlogs » ExportedLogs v O 2 Search ExportedLogs

Name Date modified Type

E LevelC2Exported 11-11-2020 14:04 AES File
E‘ LevelC1Exported 11-11-2020 14:02 XES File
E LevelB2Exported 11-11-2020 14:01 AES File
E‘ LevelB1Exported 11-11-2020 14:00 XES File
E LevelA2Exported 11-11-2020 11:59 AES File
E‘ LevelA1Exported 11-11-2020 11:56 XES File

B Attribu

B conceptname

Page 32



EXPORT

Level D1
> logs » xes_certification_import_logs » XES certification import logs » ExportedLogs v O 0 Search ExportedLogs

Name Date modified Type

E‘ LevelD1Exported 11-11-2020 14:05 XES File
E‘ LevelC2Exported 11-11-2020 14:04 AES File
E‘ LevelC1Exported 11-11-2020 14:02 AES File
E‘ LevelB2Exported 11-11-2020 14:01 AES File
E‘ LevelB1Exported 11-11-2020 14:00 AES File
E‘ LevelA2Exported 11-11-2020 11:58 AES File
E‘ LevelAlExported 11-11-2020 11:36 AES File

andard.orgftime xese
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EXPORT

Level D2
s logs » xes_certification_import_logs + XES certification importlogs » Exportedlogs v O 2 Search ExportedLogs

Narne Date modified Type

E LevelD2Exported 11-11-2020 1407 AES File
E LevelD1Exported 11-11-2020 14:05 XES File
E‘ LevelC2Exported 11-11-2020 14:04 KES File
E‘ LevelC1Exported 11-11-2020 14:02 XES File
E LevelB2Exported 11-11-2020 1401 KES File
E LevelB1Exported 11-11-2020 14:00 KES File
E‘ LevelA2Exported 11-11-2020 11:59 KES File
E‘ LevelAlExported 11-11-2020 11:36 XES File

no information available for
elected node

I lifecycle (Life

W org:aroup
I time:timestamp

I conceptname
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CONTACT INFORMATION

Contact Information

WIL VAN DER AALST CHRISTIAN GUNTHER ERIC VERBEEK
CHAIR VICE-CHAIR SECRETARY

Tel +31 40 247 4295 Tel +31 64 1780680 Tel +31 40 247 3755
w.m.p.v.d.aalst@tue.nl christian@fluxicon.com h.m.w.verbeek@tue.nl

IEEE XES Working Group

IEEE Task Force on Process Mining |EEE Task Force on

http://www.win.tue.nl/ieeetfpm

-

Process M|ing
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